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By using this handout you agrees to the use terms ocutlined on www.lesliefisher.com

Note: This handout has animated gifs. Best viewed live on the web @
http://www.lesliefisher.com/go/handouts/qgif.html

Animating Gifs on the Macintosh.

This little handout will overview two different software titles widely used in animating gifs
on the Macintosh. We will be looking at the free GifBuilder 1.0 and Adobe Image Ready
2.0 which is included in Photoshop 5.5 and higher.

What I am going to assume aka, the prerequisite stuff.

I am going to assume you already know how to make a gif in Photoshop, Appleworks,
etc. For Adobe Image Ready, | am going to assume you know how Photoshop layers
work. You can refresh your Photoshop knowledge by visiting my handouts section
(http://www.lesliefisher.com/go/handouts/conferenceresc.html) and download my

Photoshop handout.

Gi

GifBuilder

GifBuilder

GifBuilder is a free application. At the time this handout was created, the newest version
of GifBuilder is 1.0. You can find GifBuilder at http://homepage.mac.com/piquet/qgif.html.
The software includes a manual and tutorial. Because it is free, there is no technical
support. The website above does have a link to an online support newsgroup.

How GifBuilder works:

GifBuilder works on the concept of frames. Remember flip books where you flipped from
one page to the next and the motion of the changing pages created animation? Well,
that is the same process to make an animated gif in GifBuilder. You make the graphics,
place them in GifBuilder and GifBuilder animates them.

What we will do in GifBuilder:

I am going to show you how to animate text and graphics in GifBuilder. | will then
discuss additional features that you can use to enhance your animation's.

The GifBuilder desktop:
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Probably the most confusing thing in GifBuilder is the way it opens. You might not see
any windows open. If this is the case, go to your window menu and select the Frames
Window and the Preview Window.

Frames O Untitled.gif E

0 frane Length - 0,00 5 Loop : forewer Mo frams

Harne Size Fogition Disp. Delay Transp, T

This is the GifBuilder frames window.

You will be placing files in this window This is the preview

to animate them. window. Your

animation will
appear here.

Animating Text with GifBuilder:

Lets animate text. Before we get started, think about what you want your final product
to look like.

If you say..... Then you will need to create..

" 1 would like to create a text animation
where a word appears, disappears then  Two or more files of the exact same
another word appears in the exact same width and height with the different

location as the original. Maybe | would words in the same relative location in
like to do this for more words than just each file (example 1)

2-II

" 1 would like to create a text animation  Two or more files with text. You can
with words showing up in all different use GifBuilder to move the text
locations™ around. (example 2)
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Example 1: Three .gif files all the same width and height with the
text in the same location (or at least close).
O 1 untitled=1@10.. | B H O © 7 Untitled=1@ 10, | 1 O 7 uniied-1@10.. EIH
; .|.L..H'n.l.u.n.ﬁ.l...l.n[l.!:ﬂll. —- F- Lilik ﬁ Lilal Iﬂrm- [ I-FI (M| Fill Hall I
= = F
: Silly 3 :
_ E — E Example| L
100 ik . ﬁ--:-:u-. i |k - ﬁ:ll:l:lh: 4| ¥ r
Example 2: To make text move around, place it in different locations
when you make your gifs.
Example 1 animation
Example 1 animation.
I have 3 .gif files
E EFrﬂmESEE
@ @ @ 2 frames Length: 0.30 = Size: [150=50) Mo laop
silly qif tetgif  examplegi Marne Size Paosition Dizp. Delay Eansp.
silly qif 150x50  (0; 00 M o -
text gif 150:50  (0;0) M m -
exarnple gif 15050 (0, 0) M 1 -
To animate these files, drag
them into an empty frames
window. You can also use ]
the Add Frame feature in the = |
File Menu to accomplish this. -
Once completed, you screen 7
should look like something to
the right.

Would you like to see your animation, no problem. Simply go to the Animation Menu and
select Start. It will only play once. Here are some common enhancements.

Enhancing your Animation
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ltem Location What it Does

Loop your animation a

Looping Options Menu > Loop specified time or forever.

Can make the background
color clear, white, based on a
specific color.

Options Menu > Default

Transparency Transparency

Must select specific frame(s) or
all. Adds delay between
frames. Recommended.
100/100 would equal one
second.

Options Menu > Default

Frame Delay Interframe Delay

What you want to appear when
the animation stops playing.
Not Specified leaves the last

Options Menu > Default frame. Restore to background

Disposal Method will leave only the background
color. Restore to previous
frame will leave the next to last
frame as the final image.

Frame Replacement

Some other basic features:

Frames can be moved individually by clicking on them and dragging.
Hold down the control key and click on any frames to select them.
Frames can be cut and copied by using Cut and Copy in the Edit menu.

Each frame can be adjusted by clicking on it in the preview window and dragging.

To Save your Gif:

Simply go into the File menu and select save. Make ~
sure you use proper .html naming (no spaces, no Slll‘y
crazy characters, end the file in .gif) and click save.

You now have an animated gif that can be previewed

in a browser or placed on a web page.

Animating an object

Now lets animate an object. I will be using the 3 gif files which are shown below. When
the animation is played, it will make the happy face a sad face. This is a good time to tell
you | am not an artist, just a geek.
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Making this happy face a sad face is the exact same process as the text, drag the frames
in, change the order if needed and play your animation. All of the enhancements
discussed above will work.

Making this happy face a sad face is the
exact same process as the text, drag . .

the frames in, change the order if
needed and play your animation. All of
the enhancements discussed above will

work. A

Getting Fancy, GifBuilder Effects

GifBuilder has some built effects which you can use either on frames (static filters) or
between frames (dynamic filters and transitions).

Static Filters: Static filters include blur, tile, monochromatic and more. These effects
affect the frame, so, you must have one or more frames selected to use this feature. To
use a static filter, select a frame, go to the Effects menu and choose a Static Filter.

Dynamic Filters: A dynamic filter is a filter that adds frames with a more dramatic effect.
You can put them either before an existing frames to reveal them, or after to hide them.
The number of new frames which are inserted before the first selected frame is one less
than the number of steps. To use a dynamic filter, select a frame(s), go to the Effects
menu and choose a Dynamic Filter.

Transitions: To create a transition between two frames, select the second frame and
choose one of the transitions in the Effects menu. The number of new frames which are
inserted before the first selected frame is one less than the number of steps.
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o *3

) ddobe [mageReady™ 2.0
Learning Adobe Image Ready 2.0

My favorite program for animating gifs is Adobe Image Ready 2.0 which is included with
Adobe Photoshop 5.5 (full version, not limited edition).

How Image Ready Works:

ImageReady uses the layers concept from Photoshop to animate gifs. Adobe Image
Ready has an animation window which displays whatever is currently being viewed in the
graphics file layers. Let me use the example below:

O = |::| happyfacepsd @ 100°% (Origi... = F1H |LE ok
| I.a;rers\l\ Hiztory \J\ Actions | 4
| original ™ Optimized ™| 2-Up ™| 4-Up ™
Mormmal S Cpacity: [100%
.I.I.I.I.|.I.I.I.I.|1.I::I:.|I.I.I.|1.Ei|:.|l.l.l.|2.l?l.:ll.l 1. [ =02 _] P-EICl]."
z - The ﬂliginal File |:| FPreserve Transparency
v &+ | Smile
e
07 . . F . | 5ad Face
| ~ | Flat Smile =
1 4
(.
o = « | Left Eye
; (= “ |Right Eye -
|:| —
E = Big ‘Yellow Cirdle -
=] — [ |
~EEK /== GIF v =i [Framet (€] &1 ] @ |5
| Photoshop Layers|»
1
& &
L The Animation window, where it all happens!
0 =zac.-
Forever w ||| O | = [I]| B @ | KO

Yeah, | am using the happy face again. This is Adobe Image Ready. | have the
happyface file open (created in Photoshop or Image Ready) the layers window open and
the Animation window open.
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Here is how it works: Take a look at the layers window. Do you notice how | have turned
off the view of the flat smile and sad face layers? (clicking on the eye hides the layer,
note how these two layers do not have eyes showing. Now take a look at the animation,
it shows a representation of what is currently visible in the layers menu. To make the
face a sad face, | would add another frame to the animation by clicking the add frame
command (you can find this command within the triangle on the animation palette which
is located in the upper right hand corner of the animation palette), turn off the smile
layer and turn the flat smile layer back on. | would then add another frame, turn off the
flat smile layer and turn on the sad face layer. This is shown below.

r] [ I3 ]

o i
|LﬂtrsI1'H-:rrr !ﬁ:ﬂu‘u\ |T [lmrscquﬂﬁ: |l* Layers -, History ™. Actons |3
cpsty oo [ | (lems—T3) _ omy: [0 1] Cmme

] Praservs Transparency D Preserye Transparency 'EPFHH'H Transparency

sad face [ '|_nlm|- & sad face

—

Tlat ke o | 2ot At il . E_ Mat arvale
Layer 3 [ |,\____ Liyer 3 E"""" Layer 3

Lager 2 copy & || | - Layrar 2 copy 'ﬂ 1 E Ly Liger 2 copy

=, | Layer 2 '«E' || = | Layer 2 ﬁ lE = Layar 2

(O visible Layer

0 zec.- 0 zec.- 0 =sec.-

Forever Tl{hﬂl-{]|||:||[}||[}”_@|'ﬂ'_l |"|"|P—|_

| added 2 new frames of animation using the add new frame command which is found
where the triangle is. Each time | added a frame, | changed the appearance of the file by
showing and hiding layers.

To play, stop and other playback modifications
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i I ST i [
| Ammatmn\d\ 5I|ce\l\Hnllwer | 4
1
L
o
d, 0zec- 2. 1.
Fnreverﬂ.;rl{l{ll'{]llDlt}ll[}llﬁlﬁl | |P—|_

1. The right triangle plays your animation
2. The square stops your animation

3. The pop up which says forever determines the amount of time your animation will
play. Click on it to either say once or to specify a number of times it will play. You should
try your best not to have an animation play forever.

4. You can click on the upside down triangle right next to the O sec. to change the speed
of your animation, meaning it would play faster or slower. Be careful, older machines will
play it slower than average and super fast Internet connections will play the animation
fast. Never choose something very fast or very slow.

Saving your animation for the web:

To save your animated gif, go into your file menu and select Save Optimized As... You
will then be prompted to save the .gif file. Once saved it is ready to be placed on a web
page, etc.

The way cool Tween command

Lets say you wanted to move the happy face right to left on the page. Well, you could
make numerous frames, move the happy face a tad on each frame and create your
animation, but, that would be tough. Well, let me introduce you to tween. You establish
two points for your animation, where you want the happy face at the start and where
you want the happy face at the end. You then select the tween command and Let Image
Ready figure out the rest for you.
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)

| I.a;reri\k Hiztory \l\ Actions
[ Morrnal i] Opacity: [100% | »
- D FPreszerwve Transparency
3 @ ||F [ —]Happy Face
|:| 4
E B | Jiae :
3 L
5_: u
03 ’
- B :
1III 3 = |
F
03 i [ T4]» —
23K /- GF ¥ ] =] Jrrame = S AE

[
Animatmn\‘l\ Slice N\ Rollowver

1 2| The key to Tween is shown here. | h
- two frames of the same image o

| same layhr. | have simply m
to the right on the second

0 zec - G- Uuse the tween command

Forewver "Fl'i]{]I{:]lIDl[:}ll[}”_@Im_l |"|"|P—|_
This is the
dialog box
that shows Tween
up when you
select Tween. Layers: & All Layers
You will want i) Selected Layer w
to keep the [ﬁ
defaults as Parameters: [+ Position dnce
they are to [ Opacity
create your
basic tween. [ Effects
An example
of what Tween with: [ Previous Frame = ]
Tween adds
to the Frames to Add: | =48
animation
window is

shown below.
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im

Animatinn\d\ Slice \J\ Follover
4 = (=) T g = 10
3
0 zec.- 0 zec.- 0 zec.- 0 =sec.- 0 =ec.- 0 =ec.- 0 zec.-
Forever w [<1<1| <11 | O |[Z}||[3='||_@| 'ﬂ'_l | il |1|"|P_I_

A "Tweened" happy face from the example show above.

Another cool tween would be to play with the opacity levels of your layers. Imaging you
had a text layer. The first frame of your animation would have the text at 100% opacity.
You would add another frame to your animation and make the same layer 1% opacity in
the new frame of your animation. You would tween the frames and viola! Fading text !

® o
—

Making only part of an image move

Let's say you want to to make only part of an image move. For example, a panther
running, or in the example | am going to use, a dog wagging its tail. This is the toughest
animation to do, so put on your beanie propeller caps.

Here is out
cute lovable
dog. The
first step in
animating
is figuring
out what
part do you
want to
animate
and then
stick the
part you
want to
animate on
a separate
layer

| layers\l\ Histary \I\ dctions
£

[] Preserve Transparency

s [8

1002 [ »

[ Morrnal Crpacity

Layer 1

45.3K ¢/ -- alF -

& 4]

1= [Frame 1 | ]| &1 @
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In this
example, |
used the

lasso tool

to cut his
;”,‘Q;”i‘;' on |0 = 2] dogpsd @ 10Pa(0ni... =E1E
another
layer. | i)
then used
the move
tool to
move his
tail right
where it
used to be.
Look at the |
layers. You
will see
Layer 1 no
longer has ~3TK /- GF ¥ % =1 [Frame i =1 & | &
a tail and
the tail has
been
pasted onto
a new
layer.

| I.a_',rers\l\ History \l\ Actions
[ Mormal i] Cpacity: [100% | »

L
D_: D Frezerve Transparency

%h} “| tail 1
|E||_ h Layer 1

EIEIR

Now, here
is the tricky
part. 1 need
separate
layers for N
each tail
movement
I want. So s W
in this K
example, I || . J
duplicated

the tail
layer,
selected E
the new -
layer and e
selected
Transform E
in the edit |
menu and ~140K / -- GF o 278 | ] | = |Fr'ame 1 | B |
them

| dogpsd @ 100Pa (Ori... = F1H |2 o
v @ {m | I.ajrers\l\ History \l\ Actions | 3

[Nu:nr'mal i] Crpacity: 100% | »

| ll:llriginill

[[] Presarve Transparency

& |4 “| tail 2
[ [ “| il 1
IE |_ h Layer 1

4]
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moved his
tail slightly
to the left.
0 = 5’ dogpsd @ 100P(0ri... = 01 B |EE I 5
. e | | larers\l\ History \I\ dctions | 2
| hit the [ _]
M I # Cipacity: [100% | ¥
return Ifey 'y arrna pacity
to get rid of 0 - D Preserwve Transparency
the - —
Transform E & (|5 | tail 2
squares. | .
then used 5] o,
0 tail 1
my move - I_ |_
tool to E
move the 1— IE |_ h Layer 1
tail to the 0 —
corre_ct : .
location. | N
~140K £ -- GIF .-__':'_:_-'_.- '=1:]|||[::=-|Fr'ame1 EI m P_l_
4] | dogpsd @ 100P (Ori... :
el S | layers\ Histary \ Actions
...... C'pacit:.r:
D Preserwve Transparency
Now, lets [ ([ 7| tail 2
talk about
the | “ 4ail 1
animation.
This IE |_ h Layer 1
example — ¥ |
is for | ||
w
frame 1. | y | - = |
Note how -
I have tail ST ) <] IE= [Frame 1 B & &
2 hidden iE e
and tail 1 | Animatiun\‘k SIice\anllwer w
visible.

05 sec.~

05 sec.~

Forever w [ <11 <ll| O | [= |1 || E|I i |

[4]» |5
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Here is
frame 2 of
the
animation.
Note how
tail 2 is
visible and
tail one is
hidden.
Basic
movement
animation
at its
best!!

O = [+ dogpsd@10Pa(0ni.. = FE |-
orie: el B | I.a;rers‘“l\ Hiztory \dx Actions | b
rigina -
I O O N | ermal—T2)  opacity: [roos [+
IIII__: [] Preserve Transparency
£ @ | 7| tail 2
E [ | tail 1
1__: IE I_ h Layer 1
i A
. [~ B
| [4]r [+ |
40K £ - GF | <[ I [Frame 2 A=
| .ﬂmimatiun\k Slice\kﬂnllnver | 4
1 2
05 zec.- 05 zec.-
Farever v|<:1<:1|<:]|||:||[r}ll[:=-||EI|ﬂI| |"|"|P—|_

The final product! Ahhh, how cute!
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